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Objective
To provide effective content (also referred to as digital artwork or digital advertisements) by using good design practices as 
they relate to digital outdoor displays and/or digital billboards.					   

When you have hundreds of thousands of dollars worth of cutting-edge technology as your very own advertising medium, 
you don’t want to waste its capabilities. Effective content is absolutely critical for your digital display to bring about the sales 
lift you expect.

We know that the content of the message is very important: it must be relevant to the customer, brief, and to the point. But in 
addition to good content, the display message must be produced in an attractive and entertaining manner. 

To achieve our objective, we must understand the following:
What is LED digital outdoor and/or digital billboard?
A digital billboard display, sometimes referred to as LED digital outdoor advertising or a combination of these words, uses an 
array of light-emitting diodes (LEDs) to show computer-programmed images and text, which are easily changed and updated 
using VisiconnSM Display Management Solution Web-based software. 

What is day parting?
In order to achieve maximum advertising flexibility and return on investment, a display should take advantage of day parting. 
A day-parted schedule advertises time-sensitive promotions at the time they are valid and target specific demographics at 
the time they will see the billboard. With a properly scheduled Daktronics digital billboard working with VisiconnSM Display 
Management Solution, the marketing possibilities are endless. 

What is best for the artwork/content for digital displays?
The artwork/content created for LED digital billboards should be approached differently than artwork created for magazine/
newspaper advertisements or television commercials. The content on a digital display must not only be vivid and use contrast 
properly, it must be brief to be effective.

Traditional signage and advertising has one chance to convey all necessary information to customers. A digital billboard, on 
the other hand, can display multiple messages that appeal and inform customers of products and services. 
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Ineffective
	�Too many design 	

elements compete for 
	 visual importance.  
 �Too much color 

confuses the customer.
 Poor car placement does not encourage the eye’s 		
	 natural flow. 
 The local brand (Miles) and national brand 		
	 (Chevrolet) are buried in the text. 

Simple. Bold. Legible. Brief.

= Ineffective Design

Breaking it Down

Effective
 Placement of the car 
	 moves the eye 		
	 naturally to the 	
	 information. 
 Excellent use of 	
	 color contributes to the legibility.
 Fewer design elements clarify the message.
	 Web site encourages consumer to take action.

 A person 	  A service	  A product	  A local brand				  
 A national brand	  A call to action	  A price 	  A special promotion			 
 A Web site	  A location	  An event	  A specific time: Morning, Noon or Evening

Graphic designers solve visual creative problems 
using these basic principles.

The information in this guide will help you understand the use of these three basic design principles for creating digital 
display content that wins the glance and entices your client’s customers.

1Composition 2Typography 3Color

Though digital billboards show an ad for approximately 7 to 10 seconds, those that are most effective should be “devoured” 
in three seconds. Build the message based on the three-second rule. Narrow the focus and decide what your message will be.  
Make it concise. The message can be one of the following:
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Define Layout
Layout is the design principle that determines the finished look of an advertisement. The most important principle for creating 
effective outdoor content is visual prioritization of the message, or hierarchy of communication. Consumers can’t hear and 
understand four messages at once; they can’t see and understand four messages at once, either. Define the items (ABC 
levels) you want to communicate and prioritize each piece in order of importance according to the following information.	

People read in chunks of information. They scan across, then down, and pick up information in logical sections. The more 
distinct those sections of information, the faster people interpret the meaning or the purpose of the message. Visual and 
written information that overlap cause the reader to pause and sort the two apart before understanding the message. Using 
hierarchy of communication helps speed comprehension and increases retention of the message. 

Design Principle 1
Composition

Visual ClutterVisual Priority

! Tip
Ask your audience to take action, such as “Call Today.”  
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Hierarchy of 
Communication:	
Use the levels as guidelines to first capture the viewer’s 
attention with a clear, single point of communication. 
Then give the viewer definition or detail that points back 
to the first level. Finally, give them the information they 
need to inspire an emotion, an action, or a purchase.	

		
Level A: A photo, logo, service, product image 	
	 or price. Whichever is the most important 	
	 piece of information.

Level B: Supporting information that gives definition 	
	 or detail to support level A.

Level C: Relevant information that tells the customer 	
	 where, how or who to contact for the 	
	 information in levels A and B.

= Ineffective Design

! Traditional vs. 
Digital Advertising 
Some worry they will not 
be able to get all of their 
information on one frame 
or piece of artwork. So 
they add every possible 
detail they can think of. 
This mindset derives from 
traditional print advertising.
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Design Principle 2
Typography

Regular Text 

! Tip
When possible, after creating the ad, look at the content on the actual digital billboard display 
to make sure it’s easy to read.

DEFINE TYPOGRAPHY
Typography is the arrangement and appearance 
of type on a page.

READABILITY
Select easy-to-read typefaces. Large, bold fonts 
make it easier for your audience to read and 
comprehend text from different viewing distances. 
In addition, text using all capital letters is harder 
to read. Use text made up of both upper- and 
lower-case letters.

Example: 
This Text Is Easier to Read from Far Away             
THIS TEXT IS HARDER TO READ FROM FAR AWAY

Selecting effective 
Fonts 
Select fonts that are easy to read from different 
viewing distances, such as large, bold fonts. 
Remember to use text containing both upper 
and lower-case characters when you have a 
long message. Using text with all caps should 
be limited to short messages. Using a limited 
amount of text will help viewers’ readability and 
comprehension. Examples of these variations on 
text are to the right.

All Cap Text             	       

Bold Text
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= Ineffective Design

! Tip
When using a colored background, outlining the letters in black and using drop shadows can create 
interest and increase readability.

Make it a campaign
Digital advertising needs to be created differently than 
traditional print magazine/newspaper advertising because 
of the unique capabilities of the medium. Print advertising 
has one chance to convey all necessary information to 
customers, whereas digital advertising can show several 
messages in a series of rotations giving advertisers multiple 
chances to convey the necessary information to customers. 

Daktronics’  VisiconnSM Display Management Solution allows 
multiple clients to advertise separately on a digital billboard. 
The web-based software easily updates and automatically 

rotates through a series of individual clients’ digital 
advertisement slots. The slot belonging to one advertiser may 
also have unique digital content showing at each rotation. 
This provides a better chance to attract the attention of 
different demographics and promotes campaigns of ads with 
small amounts of text (i.e. information) instead of a single text 
heavy advertisement (see ineffective design image below). 

Below is a campaign of digital advertisements for a zoo 
with each ad containing similar design characteristics. The 
information is broken into five separate ads, making it easier 
for viewers to comprehend on a digital billboard rotation.

Additional Ads in this campaign

Traditional print ad design Digital advertising design
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Design Principle 3
Color

Define Color
Take full advantage of your display’s color capability by 
using rich, vibrant colors. Bright, saturated colors (colors 
with no white in them) work better than pastel or low-
contrast colors. 

Certain colors tend to evoke specific emotions or ideas, so 
choose them carefully to help support products and ideas. 
See chart below. 

The color wheel to the right features a full color range. 

Complement Tint
Tint
Hue
Shade

Yellow
Yellow
Orange

Yellow
Green

Blue 
Green

Blue 

Blue
Violet Violet 

Red
Violet

Red

Red
Orange

Orange Tint:
Hue + white 
(will lighten the 
color)

Hue:
The pure color

Shade:
Hue + black 
(will darken the 
color)

Color Wheel

COLOR EMOTIONS EVOKED

Red Stimulating, exciting, provocative, dynamic
Red Orange Domination, aggression, and action
Orange Friendly, vital, playful, energizing, inviting
Yellow Orange Illumination, wisdom, and wealth
Yellow Sunny, warming, cheerful
Yellow Green Sickness, cowardice, discord, and jealousy
Green Soothing, nature, refreshing, healing, fresh
Blue Green Emotional healing and protection
Blue Cool, quiet, serene, constant
Blue Violet Uniqueness, preciousness, royalty, and sacredness
Violet Creative, regal, spiritual, mysterious
Red Violet Energetic, happy, sweet, romantic, youthful
Black Strong, classic, elegant, mysterious

Colors and the emotions they evoke 

Need to stay away  
from two center rings

Use colors from the 
two outer rings
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Good
Contrast

Bad
Contrast

Bad
Contrast

The bottom image uses hues of red and green that have the same tonal value 
(bad contrast). It is difficult to distinguish between background and text. This 
produces an effect called “vibrating.” After converting content to gray scale 
with compositing software, the advertisement’s tonal contrast is apparent. 

Color			             Gray Scale

Measuring Tonal Contrast

! Examples of good tonal contrast in digital outdoor content.
After turning your content to gray scale, is your advertisement still readable? Do all of your 
elements stand out? If so, your content piece has good tonal contrast.

COLOR EMOTIONS EVOKED

Red Stimulating, exciting, provocative, dynamic
Red Orange Domination, aggression, and action
Orange Friendly, vital, playful, energizing, inviting
Yellow Orange Illumination, wisdom, and wealth
Yellow Sunny, warming, cheerful
Yellow Green Sickness, cowardice, discord, and jealousy
Green Soothing, nature, refreshing, healing, fresh
Blue Green Emotional healing and protection
Blue Cool, quiet, serene, constant
Blue Violet Uniqueness, preciousness, royalty, and sacredness
Violet Creative, regal, spiritual, mysterious
Red Violet Energetic, happy, sweet, romantic, youthful
Black Strong, classic, elegant, mysterious

Use Tonal Contrast
Using contrast is vital to your design because 
it helps the viewer distinguish between design 
elements. For best contrast, use tonal contrast (or 
value difference) instead of only color difference. 

Tonal contrast can be measured by using 
compositing software such as Adobe® 
Photoshop®. Simply open your advertisement 
using your preferred compositing software and 
then convert it to gray scale. You can now easily 
measure the advertisement’s tonal contrast. An 
example of this is shown on the right. 

Good Tonal Contrast

Good Tonal Contrast
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Good contrast like this makes your Content highly viewable.

Using Contrasting 
Colors
Select colors that provide good contrast to make your 
content more appealing and easier to read. Achieve 
effective contrast by using colors with different values 
(how bright or dark a color is).

Use the chart at the right to guide your design. You 
can see that yellow is a bright color with a very light-
gray value. Purple, on the other hand, is a dark color 
with a black value. Therefore, using yellow and purple 
together provides very good contrast.

By looking at the chart again, you can see that yellow 
and green aren’t the best colors to use together 
because the contrast between the two is so low. 
Solve this problem by using a darker green that has a 
darker value to increase contrast and readability.

The value range chart on this page shows you how 
each color (in this example we used red) has a 
number of values to choose from. This makes contrast 
easy to achieve.

	Color		V alue

=

=

=

=

Value Range  
of Red

light 
unsaturated  
color

dark 
saturated
color

! In a Few Seconds
Remember the product user 
must be able to see the 
artwork, scan for details, and 
make an assessment of the 
data. Do not overwhelm them 
with visual clutter.

Tip
Choose a color or graphic that supports your essential message. In this case, blue implies cool 
or cold and orange is inviting and energizing; just what you need in the morning.
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! White Backgrounds: 
Avoid white backgrounds. With LED technology, the use of emitted light, white or very 
light colors may repel the eye—not the desired response in advertising. A grave concern in most 
regulatory environments is offensive use of light or white content. Even though Daktronics digital 
displays are fully capable of producing white and pastel colors it is not recommended. Taking 
advantage of the color capabilities is thoughtful and in general more pleasing to the eye. If 
white or pastels must be used, the content should only be scheduled for daytime viewing.

Black Backgrounds: 
For digital billboards, black is the absence of color. Black is created with the use of less light. 
White is the blending of all colors and the use of more light in digital billboards. 

= Ineffective Design
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Standard Colors
Make your Digital content Pop with colors that work

TRUE COLORS

Red
R=255
G=0
B=0

Green
R=0
G=255
B=0

Blue
R=0
G=0
B=255

Yellow 
R=254
G=233
B=0

Orange
R=255
G=88
B=0 

Purple
R=182
G=52
B=187

OTHER COLORS

Yellow  
Orange 
R=255
G=182
B=15

Light  
Orange  
R=255
G=161
B=0

Sunshine
R=252
G=217
B=0

Orange
R=255
G=121
B=0

Red  
Orange 
R=255
G=88
B=0

Coral
R=255
G=109
B=66

Warm Red
R=247
G=64
B=58

Red
R=205
G=32
B=44

Medium 
Red
R=198
G=12
B=48

Salmon
R=245
G=63
B=91

Pink
R=236
G=67
B=112

Rose
R=202
G=0
B=93

Ruby Red
R=202
G=0
B=93

Rhod Red
R=224
G=17
B=157

Purple 
Pink
R=195
G=0

B=158

Dark 
Purple
R=87
G=6

B=140

Violet
R=75
G=8
B=161

Royal Blue
R=37
G=38
B=169

Medium 
Blue
R=15
G=77
B=188

Dark Blue
R=0
G=35
B=149

Aqua
R=0 
G=115
B=207

Pro Blue
R=0
G=136
B=206

Grey Blue
R=0 
G=101
B=189

Sky Blue
R=0 
G=122
B=201

Apple 
Green
R=0 
G=175
B=63

Forest 
Green
R=0 
G=121
B=52

Grass 
Green 
R=88 
G=166
B=24

Lime 
Green
R=146 
G=212
B=0

Canary
R=234 
G=223
B=0

Gold
R=233 
G=233
B=0

Dandelion
R=228
G=215
B=0

Burnt  
Umber
R=181
G=163
B=0

Dark Gold
R=193
G=187
B=0

Find information below about the RGB (red, green and blue) colors that look the best on a digital display. Choose these 
colors when building digital content/artwork/advertisements to take advantage of the full-color capabilities of your cutting-
edge Daktronics digital billboard.

True Colors: 

TRUE COLORS

Red
R=255
G=0
B=0

Green
R=0
G=255
B=0

Blue
R=0
G=0
B=255

Yellow 
R=254
G=233
B=0

Orange
R=255
G=88
B=0 

Purple
R=182
G=52
B=187

OTHER COLORS

Yellow  
Orange 
R=255
G=182
B=15

Light  
Orange  
R=255
G=161
B=0

Sunshine
R=252
G=217
B=0

Orange
R=255
G=121
B=0

Red  
Orange 
R=255
G=88
B=0

Coral
R=255
G=109
B=66

Warm Red
R=247
G=64
B=58

Red
R=205
G=32
B=44

Medium 
Red
R=198
G=12
B=48

Salmon
R=245
G=63
B=91

Pink
R=236
G=67
B=112

Rose
R=202
G=0
B=93

Ruby Red
R=202
G=0
B=93

Rhod Red
R=224
G=17
B=157

Purple 
Pink
R=195
G=0

B=158

Dark 
Purple
R=87
G=6

B=140

Violet
R=75
G=8
B=161

Royal Blue
R=37
G=38
B=169

Medium 
Blue
R=15
G=77
B=188

Dark Blue
R=0
G=35
B=149

Aqua
R=0 
G=115
B=207

Pro Blue
R=0
G=136
B=206

Grey Blue
R=0 
G=101
B=189

Sky Blue
R=0 
G=122
B=201

Apple 
Green
R=0 
G=175
B=63

Forest 
Green
R=0 
G=121
B=52

Grass 
Green 
R=88 
G=166
B=24

Lime 
Green
R=146 
G=212
B=0

Canary
R=234 
G=223
B=0

Gold
R=233 
G=233
B=0

Dandelion
R=228
G=215
B=0

Burnt  
Umber
R=181
G=163
B=0

Dark Gold
R=193
G=187
B=0

Other Colors: 
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Start with a red, green, and blue color space, also known 
as RGB, the standard in digital technology. This is the same 
mode as your TV or computer. Cyan, magenta, yellow 
and black, also known as CMYK, unlike RGB, are used for 
high resolution printing. When creating content for digital 
signage, images must be created in RGB. Use the following 
tips to create files that work best for digital signage:

Additional Principles
Tips and Techniques for Digital Billboard Content Success

In Photoshop:
To see if your image is 
CMYK or RGB: 
	 Look at the title bar.  
	T he color mode is next to 	
	 the file’s name.
	 The color mode should be 	
	RGB /8 bit.

Creating a New File:
	F ile > New 
	 In Color Mode drop-down 		
	 menu, select RGB. 

Converting from CMYK 
to RGB:
	I f the image has layers, 		
	 you will be given the option 
	 of flattening your image 	
	 when converting to 		
	RGB . The best practice if
	 you already have a CMYK 	
	 image is to finish in that
	 color mode, then convert 	
	 to RGB and flatten the 		
	 layers when possible. 		

 Build content in its native measurement (pixel by pixel - 
  not inch by inch) Example: 888 w x 260 h.

 Save files as JPEGs.

 72 ppi is recommended for resolution for this technology.

	N ote: Colors may shift 	
	 when converting from 		
	C MKY to RGB.
	T o convert a flattened 		
	 image (1-layer), go to
	 Image > Mode > 
	RGB  Color.

In Illustrator:
To see if your image is 
CMYK or RGB:
	 Look at the title bar.  
	T he color mode is next to 	
	 the file’s name.
	 The color mode should 
	 be RGB.

Creating a New File:
	 File > New
	 Select RGB radio button.

Converting from CMYK 
to RGB:
	 File > Document Color 		
	 Mode > RGB Color

In Photoshop: 
Compressing File Size:
	 Open the file in Adobe 		
	P hotoshop.
	C hoose “Save As.” 		
	R ename your file. Choose 	
	 .jpg format. 
	A  window will come up. 	
	 Move the slider bar in the 	
	 center to the left in order to 	
	 compress the file size.
	 Use the “File Size” 		
	 instructions, left, to 
	 view file size. If it is still 		
	 too big, repeat the 		
	 directions above.

In Illustrator:
Compressing File Size:
	 Open the file in Adobe 		
	I llustrator.
	C hoose “Save As.” 		
	R ename your file. 
	C hoose .eps format. 
	T his will compress the
	 file size.

Color Mode File Size
To Check File Size:
	U nder “My Computer,” identify the image you wish to 	
	 check. Right click on the .jpeg image.
	C lick on “properties.” This will show the properties of the 	
	 image you created.   
	T he file size should be listed in the middle of the panel.    
	T he file size should be around 70-150KB. 
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IMPORTABLE IMAGE FILES
•	 Choose photos to import that have a smooth gradation (smooth change from one color to another) of color shades 
	 and don’t contain much detail.
•	 You may need to change the size of an image to fit your display and then crop it so it will look its best.
•	 For the most attractive images, use those in raster format (.jpg, .png, .gif, .bmp, and .tif) and set them at 72 ppi.
•	 Logos appearing on a black or colored background will be more effective than logos on a white background.

! Tip
Add interest—show only a portion or the focal point of an image. Examples above.

Focal Point of the image

Image for digital advertisement
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Examples of Dynamic Content
Dynamic Content is defined as the ability to automatically update data within a creative template utilizing a RSS feed.

Interact with audiences by displaying interactive content, such as time and temperature, the artist and song on a featured radio 
station, hospital ER waiting times, and live feeds. Talk to your Daktronics representative about our dynamic content options. 

Creative Template Creative template with Data
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